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1. Overview
This chapter describes the UWBTracer™ product and Ultra-Wideband  
technology in general. It also provides UWBTracer specifications.

1.1 UWBTracer Ultra-Wideband Analyzers
The LeCroy UWBTracer is a portable Ultra-Wideband (UWB) test and 
debug platform that combines non-intrusive recording with extensive 
decoding features. The UWBTracer MPI analyzer is designed to connect to 
the MAC-PHY Interface (MPI) bus between the MAC and the PHY 
sub-systems in WiMedia-compliant devices and to capture the traffic 
between them.

By leveraging years of experience in protocol analysis tools for emerging 
markets, UWBTracer blends sophisticated functionality with practical 
features to allow designers and validation engineers to easily specify 
multi-level, conditional trigger scenarios to pinpoint intermittent problems 
in the UWB connection.

System-level validation requires non-intrusive monitoring. UWBTracer 
ensures accurate data collection by providing transparent electrical taps. At 
the heart of UWBTracer is the CATC BusEngine™ protocol processor that 
features a real-time recording engine for UWB MAC-to-PHY traffic.

UWBTracer also supports remote operation over a LAN and unattended 
control of the analyzer with an Automation API. UWBTracer includes an 
advanced search capability that allows to search for specific fields in the 
recorded trace and to navigate faster to places of interest inside the trace.

UWBTracer features a real-time statistics display that continuously 
monitors and presents metrics for the recorded MAC-to-PHY traffic, 
providing a high-level view of network performance. 

For complete product information, please visit www.LeCroy.com.

Table 1.1 summarizes key UWBTracer features.
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1.2 Ultra-Wideband Technology 
UWB technology was available for over 40 years for military and civilian 
applications and was originally called either impulse radio or carrier-free 
communications. Today, the FCC definition for UWB is any radio 
technology with a spectrum that occupies greater than 20 percent of the 
center frequency or a minimum of 500MHz. 

In 2002, the FCC allocated unlicensed radio spectrum from 3.1 GHz to 10.6 
GHz expressly for enterprise and consumer applications. The FCC defined 
a specific minimum bandwidth of 500 MHz at a -10dB level. As current 
UWB implementations allow communication that requires high data rates 
over short distances, one immediate UWB application is WPAN (Wireless 
Personal Area Network).

The Multi-band OFDM technology, promoted by the WiMedia Alliance, is 
one of the technologies that can utilize the allocated band for UWB. It is 
already used in other commercial communications systems, including 
Wi-Fi 802.11a/g, WiMAX 802.16a and others. The MB-OFDM transmits 
data simultaneously over multiple carriers spaced apart at precise 
frequencies. This approach provides benefits like high spectral flexibility 
and resiliency to RF interference and multi-path effects. 

Table 1.1  UWBTracer Features

Feature Benefit

Two types of MPI probe connectors Suitable for popular connector types used in UWB 
WiMedia systems to connect between MACs and 
PHYs.

Trace View Robust capability to control real-time triggering, 
filtering, and trace display options.

Advanced search Fast and comprehensive trace searches.

Collapsible /expandable header Increased drill-down on exchanges, sequences, or 
individual frames.

Real-time performance monitoring and statistics Allows easy identification of throughput problems 
and anomalies.

Dynamically-allocated memory pool (2GB) Captures long time-windows for analysis and 
problem-solving.
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The WiMedia Alliance, which is composed of the MBOA (Multi-band 
OFDM Association) and the WiMedia group, drives the efforts to create an 
ecosystem that would allow easy and secure operation of UWB devices. A 
data-rate targeted at 480Mbps would provide the ground for delivering 
Wireless-USB (WUSB) devices. To complete the picture, the USB-IF 
organization is responsible for the effort to establish the WUSB 
specification.

The WiMedia UWB specifications are available from the WiMedia 
Alliance. The URL for the WiMedia website: 

 http://www.wimedia.org

The WUSB specification is available from the USB Implementers Forum 
(USB-IF): The URL for the USB-IF website:

http://www.usb.org/home
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2. General Description
This chapter describes UWBTracer™ MPI product components and 
general physical features.

2.1 System Components
• One UPAS 10K base platform.
• One MPI Module Plug-In to be plugged into Slot #1 (left-side slot).
• One Cable Adapter.
• One Cable Adapter connector cable.
• One 68-pin MPI probe cable.
• One 40-pin MPI probe cable.
• Breakout board with cable.

2.2 UWBTracer Front Panel Description
When powered ON, the UWBTracer MPI activates user-accessible controls 
and LEDs on front and rear panels of the UPAS base platform. This section 
covers front panel features. The next section covers rear panel features.

Figure 2.1 UWBTracer Front Panel

WARNING

Do not open the UPAS enclosure. There are no operator serviceable parts inside. 
Refer servicing to LeCroy.
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Front Panel LEDs

UPAS LEDs (Figure 2.1, from left to right)
Power indicator LED: Lights when the unit power is switched ON.
System Status indicator LED: Lights during initialization/power up of 
UPAS base unit. Blinks if a self-test fails.
Recording LED: Lights when the unit is recording.
Triggered LED: Lights when the unit triggers on an event.
Synchronized LED: Lights when the analyzer is synchronized and can 
record traffic.

UWBTracer MPI Module
Status LED: OFF if Cable Adapter cable is not attached or PCLK is not 
detected. Blinks every one second as soon as PCLK is detected. Blinks 
continuously as soon as PHY_ACTIVE is detected (RX or TX frame is in 
progress).

Front Panel Pushbutton
Manual Trigger push-button: Forces a trace trigger when recording 
options are set to “Manual Trigger.”

2.3 UWBTracer Rear Panel Description
From left to right, the UPAS rear panel contains the following components:

Figure 2.2 UWBTracer Rear Panel

USB Type "B" Host Computer Connector: This connector links the 
analyzer to the Host PC (PC running the UWBTracer software application). 
It allows the PC to transmit commands to the analyzer and to upload traces 
from the analyzer recording memory to UWBTracer software for viewing 
and analysis.

RS-232 25 pin "Data Input/Output" Connector: This connector links a 
40-pin RS-232 cable to an external breakout board.
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The breakout board allows signals to be sent from the analyzer to an external 
device such as an oscilloscope or from an external device to the analyzer for 
the purpose of triggering on external input. You set input/output signalling 
through the Recording Options window.

BNC Connectors "Ext. In" and "Ext. Out": These BNC connectors 
allow the analyzer to transmit or receive external signals.

AC Connector Module: The connector module is located on the right side 
of the rear panel. Key features are:

• Power socket.
• Power ON/OFF switch.
• Enclosed 5x20 mm 2.0A 250 V fast-acting glass fuse.

WARNING

For continued protection against fire, replace fuse only with the type and rating 
specified above.
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3. Installation
This chapter describes how to install the UWBTracer™ MPI System.

3.1 Analyzer PC Requirements
Please see the Readme file on the installation CD for the latest information 
on PC requirements.

3.2 Installing the UWBTracer Software
To install UWBTracer software on its PC host.

Step 1 On the PC, select Install Software from the installation 
window and follow the on-screen instructions.

Step 2 The UWBTracer software will install on the PC hard disk.

Step 3 To start the application, launch the LeCroy UWBTracer 
program from the Start menu: 

Programs > LeCroy > UWBTracer
The UWBTracer program opens.

Note:  You can use the software with or without the analyzer. When used 
without the analyzer connected to the computer, the program functions 
as a trace viewer to view, analyze, and print trace files.

3.3 Setting Up the Analyzer
To set up the system:

Step 1 Remove the UWBTracer/UPAS from its shipping container.

Step 2 Connect the analyzer unit to a 100-volt to 240-volt, 50 Hz to 
60 Hz, 120W power outlet using the provided power cord.

Step 3 Turn ON the power switch on the rear of the UPAS.
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Note:  At power-on, the analyzer initializes itself in approximately 10 
seconds and does an exhaustive self-diagnostic that lasts about 5 
seconds. The Status LED of the UPAS base unit turns red on power 
up/initialization. The LED remains on approximately 25 seconds while 
the analyzer performs its self-diagnostic testing. If the diagnostics fail, 
the Status LED blinks red, indicating a hardware failure. If this occurs, 
call LeCroy Customer Support for assistance.

Step 4 Connect the USB cable between the USB port on the back of 
the analyzer and a USB port on the PC.

The host operating system detects the analyzer and begins to install 
the USB driver.

Step 5 Follow Windows on-screen Plug-and-Play instructions for 
the automatic installation of the analyzer as a USB device on 
the Host PC (the required USB files are included on the 
UWBTracer CD). 

Step through the Windows hardware wizard. The wizard will 
automatically install UWBTracer as a USB device on the PC.
When the wizard prompts you for driver information, point it to the 
CD, which should be in your disk drive, and install ctcupa10.sys 
and uwbtrace.sys.

3.4 Connecting the Analyzer to the Device Under Test
Assuming you are using an MPI cable adapter, following are UWBTracer 
MPI components used in the installation:

• UPAS 10K system with the UWBTracer MPI plug-in module.
• Cable Adapter with connector cable.
• One of the probe cables: the 68-pin version or the 40-pin version 

(depending on the available connector on the device under test).

3.5 Installing the Cable Adapter
To install the cable adapter:

Step 1 If not already powered OFF, power OFF the UPAS 10K 
analyzer and the device under test (DUT).

Step 2 Connect one side of the adapter cable to the MPI plug-in 
connector labeled TO ADAPTER (Figure 3.1). 
10
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Step 3 Connect the other side of the adapter cable to the cable 
adapter cable connector labeled TO ANALYZER.

Step 4 Connect the middle connector of the chosen probe cable to 
the respective connector in the cable adapter (either labeled 
68 PIN INPUT or 40 PIN INPUT). Figure 3.1 shows a 
40-pin probe cable connected to the 40-pin connector.

Step 5 Connect one side of the probe cable to the connector at your 
PHY system. Connect the other side of the probe cable to the 
connector at the MAC system.

3.6 Cable Adapter Pin Assignments
Table 3.1 and Table 3.2 show connector pin assignments for the 68-pin and 
40-pin probe cables.

Figure 3.1 UWBTracer Device Connections

Connector labeled
"To Adapter"

Connector labeled
"To Analyzer"
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Table 3.1  Adapter Pin Assignments: 68-Pin Probe Cable

PIN# Definition PIN# Definition

A1 N/C B1 N/C

A2 GND B2 GND

A3 DATA[0] B3 PHY_RESET

A4 GND B4 GND

A5 DATA[1] B5 N/C

A6 GND B6 GND

A7 DATA[2] B7 MCTL

A8 GND B8 GND

A9 DATA[3] B9 SERIAL_DATA

A10 GND B10 GND

A11 DATA[4] B11 CCA_STATUS

A12 GND B12 GND

A13 DATA[5] B13 CCA_REQ

A14 GND B14 GND

A15 DATA[6] B15 N/C

A16 GND B16 GND

A17 DATA[7] B17 N/C

A18 GND B18 GND

A19 PCLK B19 N/C

A20 GND B20 GND

A21 N/C B21 N/C

A22 GND B22 GND

A23 TX_EN B23 N/C

A24 GND B24 GND

A25 RX_EN B25 N/C

A26 GND B26 GND

A27 FSYNC B27 N/C

A28 GND B28 GND

A29 PHY_ACTIVE B29 N/C

A30 GND B30 GND

A31 DATA_EN B31 +5V

A32 GND B32 GND

A33 EOF B33 +V5

A34 GND B34 GND
12
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Table 3.2  Adapter Pin Assignments: 40-Pin Probe Cable

PIN FUNCTION PIN FUNTION

1 RESET 2 GND

3 DATA0 4 NC

5 DATA1 6 PWR

7 DATA2 8 PWR

9 DATA3 10 PWR

11 DATA4 12 PWR

13 DATA5 14 PWR

15 DATA6 16 PWR

17 DATA7 18 NC

19 GND 20 KEY

21 PCLK 22 GND

23 TX_EN 24 GND

25 RX_EN 26 GND

27 PHY_ACT 28 NC

29 DATA_EN 30 GND

31 CCA_ST 32 GND

33 SE_DAT 34 GND

35 STOP_C 36 GND

37 RSVD1 38 GND

39 RSVD2 40 GND
 13
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3.7 Making a Recording
After installation, the software is configured by default for a 16-MB 
snapshot recording of your traffic. 

Starting Recording
To start recording:

Step 1 Check that the analyzer is properly connected to the Cable Adapter 
and host PC. Check that the Cable Adapter is properly connected to 
the DUT.

Step 2 From the Setup menu, select Recording Options. The Recording 
Options window appears (Figure 3.2).

.

Figure 3.2 Recording Options Window: General Settings
14
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Step 3 Select the General tab. 

The General page of the window appears. It displays the default 
settings for items like Recording Type and Buffer Size. For your 
first recording, you can leave these settings unchanged.

Step 4 Click  on the Tool bar. After 16 MB of traffic is recorded, the 
UWBTracer analyzer uploads the data and displays the frames.

Stopping Recording
You can stop the recording at any time by pressing the Stop Button .  
Afterwards, the trace will automatically upload from the analyzer to the PC.

Interrupting the Upload Process
You can interrupt the upload process by pressing the Stop  button.  
Pressing Stop will cause the Abort or continue uploading dialog box to 
appear (Figure 3.3).

 

Figure 3.3 Adjust Uploading Dialog Box

This dialog presents the following options for stopping, continuing, or 
aborting the recording.

Stop: Stop upload but keep the data that has been uploaded to this point.

Continue: Continue with the upload process.

Flush: Abort the upload process and flush the data uploaded to this point.
 15
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Saving the Trace
When the recording session is finished, traffic is uploaded to the PC and is 
automatically saved to the hard drive as a file named data[sn].uwb, where 
[sn] is the serial number of the UPAS 10K chassis (or the name you assign 
as the default filename).

Figure 3.4 Trace Display

To save the trace:

Step 1 To save a current recording for future reference, select Save As from 
the File menu.

Step 2 Give the recording a unique name and save it to the appropriate 
directory.
16
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4. External Interface Breakout Board
This chapter describes the Breakout Board included with UWBTracer.

4.1 Breakout Board Overview
With each analyzer, LeCroy includes an External Interface Breakout Board 
(Figure 4.1). The board provides analyzer access to several potentially 
useful standard, LV TTL output and input signals. The breakout board also 
provides a simple way to connect logic analyzers or other tools to the 
UWBTracer analyzer. Six ground pins and one 5-volt pin are provided.

Figure 4.1 External Interface Breakout Board

The Breakout Board contains a prototype rework area for making custom 
circuits for rapid development. You can use the rework area to insert custom 
components and wire-wrap their respective signal, power, and ground pins. 

The prototype rework area consists of plated-through holes, 20 columns 
wide by 27 rows long. The top row of holes is connected to GND and the 
bottom row is connected to +5V. The remaining holes are not connected. 
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4.2 Data In/Out Connector
The Breakout Board connects via a cable to the Data In/Out connector 
located on the UWBTracer rear panel. Each signaling pin is isolated by a 
100Ω series resistor and a buffer inside the analyzer.

Figure 4.2 Breakout Board Data In/Data Out Connector

Table 4.1 lists pin-outs for the 25-pin Data In/Out connector.  

 
Table 4.1 Pin-Outs for Data In/Out Connector

Pin Signal Description

1 RSV Reserved
2 GND Ground
3 GP OUT General Purpose Output
4 TRG IN 1 Trigger In 1
5 GND Ground
6 DATA 6 Data 6
7 DATA 4 Data 4
8 DATA 3 Data 3
9 DATA 1 Data 1

10 GND Ground
11 RSV Reserved
12 RSV Reserved
13 +5V +5 Volts, 250 mA DC Source
14 RSV Reserved
15 GND Ground
16 TRG OUT Trigger Out
17 TRG IN 0 Trigger In 0
18 DATA 7 Data 7
19 DATA 5 Data 5
20 GND Ground
21 DATA 2 Data 2
22 DATA 0 Data 0
23 GND Ground
24 RSV Reserved
25 RSV Reserved
18
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Note:  Pins 4 and 17 have the same function: To allow external signals to 
be used to cause triggering or recording. 
Pins 3 and 16 are used to transmit output signals. 
Pins 6, 7, 8, 9, 18, 19, 21, and 22 (data pins) are used to define data patterns 
for external input signals.
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5. Software Overview
This chapter describes key features of UWBTracer software. 

5.1 Starting the UWBTracer Program
You can use the UWBTracer with or without the analyzer unit. When used 
without an analyzer, the program works as a trace viewer to view, analyze, 
and print trace files.  

To start the UWBTracer Program from the PC Start menu:

Step 1 Click Start.

Step 2 Select Programs.

Step 3 Select LeCroy.

Step 4 Click LeCroy UWBTracer.

The application display appears (Figure 5.1).

 

Figure 5.1 UWBTracer Main Window
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5.2 Opening Sample Traces
A good way to gain familiarity with UWBTracer is to open some of the 
provided sample files and explore the menus, pop-up menus, and reports. 

5.3 Opening Older Trace Files
The UWBTracer software has the capacity to open trace files created with 
earlier software versions.  When an older trace file is opened, the user will 
be prompted to convert the file to the current software version.

5.4 Tool Tips
Throughout the application, Tool Tips provide useful information about  
buttons on the toolbar.

To display a Tool Tip, position the mouse pointer over an item of interest 
such as part of the trace or a button (Figure 5.2).

Figure 5.2 Tool Tip

5.5 Trace Tool-Tips
Many fields within the Trace display tool-tips when the mouse pointer is 
suspended over them.  These tips may provide a simple legend for the cell 
or may give substantial added details about the field (Figure 5.3).

 

Figure 5.3 Trace Tool Tip
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5.6 Menu Bar
Table 5.1 lists menus available from the Main window menu bar.

Table 5.1  Menu Bar Menus

Menu/Option Function

File

Open… Opens a trace file or traffic generation file.
Close Closes the current trace or generation file.
Save As… Saves all or a specified range of frames from the current file with a 

specified name.
Print… Prints part or all of the current trace or traffic generation file.
Print Preview Produces an on-screen preview before printing.
Print Setup… Sets up your current or new printer.
Edit Comment… Opens a dialog for entering a brief comment about the trace.
Export Packets to Text (Packet View Format) - Saves all or part of a trace 

to a text file.  Useful for saving traces to floppy disk and for 
e-mailing. 

Exit Exits the UWBTracer program.

Setup

Display Options Opens a window that controls the recording process.
Recording Options Opens a window that controls display options.
Update BE/FW...
Analyzer Network ... Opens a dialog box for browsing to local and networked analyzers.  

Within the dialog, click Add to browse.  The dialog lists PCs that 
are on the LAN.  If a PC has an analyzer attached to it, and if 
DCOM permissions have been set on the selected PC, clicking 
Select establishes a connection. 

All Connected Devices ... Opens a dialog box with a list of analyzers connected to the host 
PC.  Lets you select an analyzer and update the BusEngine, 
Firmware, and licensing information.

Record

Start Causes the Analyzer to begin recording.
Stop Causes the Analyzer to stop recording.

Report

File Information Displays information about the recording such as the number of 
frames and triggering setup.

Timing Calculations Calculates timing between two frames.

Search

Go to Trigger Positions the display to show the triggering event at the top.
Go to 
PLCP/Packet/Transaction/Transfer...

Positions the display to show a specific frame or decode level.

Go to Marker Positions the display to the selected marked frame.
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5.7 Tool Bar
The Main window Tool bar provides quick access to most UWBTracer 
software functions. You can learn the function of each button by passing the 
mouse pointer over it. Button descriptions appear on the Status bar at the 
bottom of the window and as tooltips above each button.

Go to Positions the display to the specified item.
Find ... Allows searches by multiple criteria.
Find Next Looks for the next instance of an event specified with Goto or Find.
Search Direction Allows the search direction to be changed from forward to 

backwards or backwards to forward.  

View

Toolbars Displays list of available Tool bars.
Analyzer Network Chat Bar Opens a dialog that allows users to conduct chat sessions over an IP 

LAN.  In order to send and receive electronic text messages, each 
user must be working with a PC that is on an IP LAN and also 
attached to an analyzer.  .

Status Bar Switches display of the Status Bar ON or OFF.
Unhide Cells Unhides cells hidden by Display Options.
Zoom In Increases the size of the displayed elements.
Zoom Out Decreases the size of the displayed elements.
Wrap Wraps displayed Frames within the window.
Real-Time Statistics Displays trace statistics.

Window

New Window Opens another instance of the Main Window.
Cascade Displays all open Main Windows in cascaded format.
Tile Horizontal Displays all open Main Windows in tiled horizontal format.
Tile Vertical Displays all open Main Windows in tiled vertical format.
Arrange Icons Arranges Main Window icons at bottom of display area.

Help

Help Topics ... Opens online help.
Update License ... Opens a dialog box for entering license key information for the 

analyzer.
Display License Information ... Opens a dialog box with information about the current status of the 

analyzer's license
About UWBTracer Displays version information about UWBTracer.

Table 5.1  Menu Bar Menus (Continued)

Menu/Option Function
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Figure 5.4 Main Window Toolbar

General Buttons

Hide Buttons

Table 5.2  Main Toolbar Buttons: General

Open file Zoom In

Save As Zoom Out

Setup Recording Options Wrap

Setup Display Options Find

Start Recording Find Next. Repeats last find.

Stop Recording

Table 5.3  Main Toolbar Buttons: Hide

Hide Unassociated Traffic Hide Beacon Frames

Hide Devices Hide Empty DN Frames

Hide Empty Super Frame
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Reports Buttons

Decode Buttons

5.8 Floating the Decode Toolbar
You can float any of the toolbars by dragging them from their current 
location at the top of the screen.  If you float the decode toolbar, it will 
arrange the decode buttons so they reflect their hierarchical order. 

 

Figure 5.5 Decode Toolbar in Hierarchal Arrangement

5.9 Pop-Up Menus
Pop-up menus within the trace provide options for formatting the trace. 

Table 5.4  Main Toolbar Buttons: Reports

File Information Report.  Opens a 
summary of general information about 
the trace file.

Traffic Summary. Opens a summary of 
protocol-related information in the trace 
file.

.Error Report. Opens a summary of 
error information in the trace file.

Real-Time Statistics. Opens a window 
that shows realtime information on links 
activity.

Timing and Bus Usage Calculations.  
Opens a calculator for measuring 
timing between frames

Table 5.5  Main Toolbar Buttons: Decode

View MPI Trace Level View WUSB Transaction Level

View WUSB Packet Level View WUSB Transfer Level
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Left Mouse Button
Opens a menu for expanding fields, viewing data fields, and formatting the 
trace. The menu is context-sensitive and changes, depending on what part 
of the trace you have clicked. Figure 5.6 shows three examples.

Figure 5.6 Trace Pop-Up Menus

Following are common options that appear on most menus:
Format: Presents choices for changing the numerical formatting of the 
data fields throughout the trace.
Color: Presents choices for changing the color of the data fields throughout 
the trace.
Hide: Hides data fields throughout the trace.  To re-display hidden fields, 
right-click anywhere in the trace and select Unhide Cells and then one of 
the options from the sub-menu.

Right Mouse Button
If you click a cell in the trace with the right mouse button, a pop-up menu 
appears and shows the options for zooming in or out, wrapping the display, 
and other formatting options (Figure 5.7).

Figure 5.7 Trace Cell Pop-Up Menu
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5.10 Status Bar
The Status Bar is located at the bottom of the Main window. Depending on 
the current activity, the bar can be divided into as many as four segments.

Recording Progress
When you begin recording, the left-most segment of the Status bar displays 
a recording Progress Indicator (left side of Figure 5.8). 

Figure 5.8 Example: Status Bar at Different Recording States

Keep the following in mind when reading the Progress Indicator:

• A black vertical line illustrates the location of the trigger position 
you selected in the Recording Options window. The pre-trigger 
progress is displayed in the field to the left of the trigger position. 

• When the trigger position is reached, the progress indicator wiggles 
as it waits for the trigger. 

• After the trigger occurs, the field to the right of the trigger fills in 
the post-trigger color specified in the Display Options window.

• When recording is complete, the upper half of the Progress 
Indicator fills in white, indicating the progress of the data upload to 
the host computer.

Some other key points about the Progress Indicator:

• If a trigger event occurs during the before-trigger recording, the 
before-trigger color changes to the after-trigger color to indicate 
that not all the expected data was recorded pre-trigger. 

• When you click Stop before or after a trigger event, the Progress 
Indicator adjusts to begin uploading most recently recorded data.

• If you wish to abort an upload that is in progress, click the Stop 
button again.

• The Progress Indicator fills with color in proportion to the specified 
size and actual rate at which the hardware is writing and reading the 
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recording memory. However, the Progress Indicator is normalized 
to fill the space within the Status bar.

Recording Status
During recording, current recording status is displayed in the next segment 
of the Status bar. When recording is begun, one of the following messages 
flashes (depending on options selected in the Recording Options window):

• Trigger?.
• Triggered!.
• Uploading.

After recording stops, The following occurs:

• Flashing message changes to Uploading data–x% done (x% 
indicates the percentage completion of the data uploading process). 

• Traffic data is copied to disk (overwriting any previous version of 
this file) using the default file name data.sas. You can also create a 
file name of your choice by specifying one in the Recording 
Options window.

To abort the upload process, press the Stop button.

You are asked if you want to keep or discard the partially uploaded data.

When the data is saved, the Recorded Data file appears in the Main display 
window, and the Recording Status window is cleared. 

• If the recording resulted from a trigger event, the first frame 
following the trigger (or the frame that caused the trigger) is 
initially positioned second from the top of the display.

• If the recording did not result from a trigger event, the display 
begins with the first frame in the traffic file.

Recording Activity
During recording, the fourth segment from the left of the Status bar displays 
recording activity as a series of vertical bars. 

The more vertical bars that are displayed, the greater the amount of activity 
being recorded.  If there are no vertical bars, there is no recorded activity. 

During uploading, the percent of the completed upload is displayed.

Search Status
The rightmost segment of the status bar displays current search direction: 
Fwd (forward) or Bwd (backward).  
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5.11 View Settings Tools
You can zoom in and out, and wrap the trace to fit within the screen by using 
the following buttons:

Zoom In
Increases the size of the displayed elements, allowing fewer (but larger) 
Frame fields per screen. 

Click  on the Tool bar.

Zoom Out
Decreases the size of the displayed elements, allowing more (but smaller) 
Frame fields per screen. 

Click  on the Tool bar.

Wrap
Adjusts the Trace View so that frames fit onto the next line if they are longer 
than the size of the window. Without wrap, you can use the horizontal scroll 
bar to see the hidden part of a frame.

Click  on the Tool bar. 

Figure 5.9 Trace With Wrap Turned OFF

In Figure 5.9, the timestamp extends off the right edge of the screen.

Figure 5.10 Trace With Wrap Turned ON

In Figure 5.10, the entire frame appears in the window.
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5.12 Adding Comments to the Trace
You can create, view, or edit the 100-character comment field associated 
with each Trace file.
Step 1 From the File menu, select Edit Comment.

The Edit Trace Comment Dialog box appears.
Step 2 Create, view, or edit the comment.

Step 3 Click OK.

Figure 5.11 Edit Trace File Comment Dialog Box

5.13 Set Marker
The Set Marker feature allows frames to be marked so you can navigate 
back to events of interest.  Markers also provide you with a way of tagging 
events so you can perform timing calculations between them.

The Set Marker command works in conjunction with the Go to Marker 
feature.  Once you have marked a frame, you can navigate back to it by 
selecting Search > Go to Marker, and then selecting the marker of interest 
from the list.

To set a marker on a frame: 

Step 1 Click on Frame # for the frame you wish to mark.

Step 2 From the pop-up menu that appears, Select Set Marker 
(Figure 5.12).

Step 3 The Edit Market for Frame # dialog box appears 
(Figure 5.13).

Step 4 Enter your comment. 

Step 5 Click OK.

Step 6 A marked frame is indicated by a vertical red bar along the 
left edge of the Frame # block (left side of Figure 5.14).
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Figure 5.12 Setting a Frame Marker

Figure 5.13 Edit Marker for Frame Dialog Box

Figure 5.14 A Marked Frame
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5.14 Edit or Clear Marker
To clear or edit comments associated with a Frame marker, 

Step 1 Click on Frame # for the chosen packet.

.

Figure 5.15 Editing a Frame Marker

Step 2 A pop-up menu appears (Figure 5.15). To edit the marker comment, 
select Edit Marker.

The Edit Marker for Frame # comment window appears 
(Figure 5.13).

Step 3 Edit the comment as desired.

Step 4 Click OK.

Step 5 To clear a marker, click Clear marker in the frame pop-up menu 
(Figure 5.15). The vertical red Marker bar disappears.

5.15 Timing Calculations on Markers
You can use markers as reference points to calculate timing between events.  
To do a timing calculation:

Step 1 Click on the frame # that you want to use as the first point of 
reference in the time calculation (from MPI).

Step 2 In the pop-up that appears, select Time from Marker 
(Figure 5.15). The following appear: 

Timing Calculator dialog box (Figure 5.16) 
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All Markers window (Figure 5.17). 
Step 1 In the All Markers window, select the marker that you want 

to use as the second point of reference in the time calculation 
(To MPI).

Step 2 The time between the two markers appears in the Timing 
Calculator dialog box.

Figure 5.16 Timing Calculator Dialog Box

Figure 5.17 All Markers Window
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6. Display Options
This chapter describes how to use the Display Options window.

6.1 Display Options Overview
You can use the Display Options window to specify how the UWBTracer 
software displays trace information. The window has two tabs. the General 
tab, and the Color, Formatting, and Hiding tab. Each tab brings up a separate 
page of the window:

General: To set general characteristics of a trace view, including zoom 
level, whether or not tool tips are displayed, and use of timestamps.
Color, Formatting, and Hiding: To customize the colors and formats 
associated with each field in the trace view or to hide fields within a trace.
To go to the Display Options window:
Step 1 From the Setup menu, select Display Options. 
Step 2 The Display Options window appears (Figure 6.1).

Note:   When the Display Options window appears, the General page is 
on top (it is the default page).

Fill out the various areas of the window as described in following sections.
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Figure 6.1 Display Options Window: General Page

6.2 Display Options: General
You set general options on the General page. The page is divided into a 
general setting area on the left (for zoom level, enable tips, etc.) and a Trace 
Viewing Level area on the right. The options available in these areas are:

Zoom Level: Adjustable in discrete increments from 10% to 200% 
percent.
Enable Tips: Select to enable Tool Tips with explanation text to pop up 
when you position your cursor over various fields in the Trace View.
Wrap: Causes packets to wrap within the window if their length exceeds 
the width of the window.
Right click cell context menu:  Activates the right mouse button for 
opening cell context menus.
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Hierarchy Lines:  Adds faint lines (to the left side of the trace that show 
the hierarchical relationship of the frames, transactions, etc. within the 
trace (Figure 6.2).  When this option is enabled, the lines display any time 
you cascade higher level decodes.

Figure 6.2 Trace Hierarchy Lines

Timestamp At The Beginning:  Moves the timestamp from the end of the 
frame to near the beginning.
Analysis Tools: Opens the error report, traffic summary, or real-time 
statistics displays (you can also open the displays via tool bar buttons).
Fonts: Controls the appearance of fonts in the trace display.
Configuration Name: Comment field associated with the *.opt file 
containing the current display options values. You can also create and store 
your unique display options for future use. 
To create a new Display Options file:

Step 1 Enter a comment for the new file in the Display 
Configuration Name field.

Step 2 Click Save...

Step 3 Specify a filename (*.opt).

Step 4 Click Save.

Trace Viewing Level: Allows you to select the hierarchical level at which 
traffic is displayed.

6.3 Display Options: Color, Formatting, and Hiding
Use the Color, Formatting, Hiding page to customize the colors and formats 
associated with each field in the trace view or to hide fields within a trace 
(Figure 6.3).
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Figure 6.3 Display Options Window: Color, Formatting, and Hiding Page

Setting Colors
Use the Group and Color pane to customize the colors associated with each 
field in the trace.  You can experiment  to achieve the color combination best 
suited to a particular graphic system.

To change the colors of elements in the trace, select an item in the Group 
and Color pane and use the color pallet area to make the desired changes. 
The color pallet area is located to the right of the Group and Color pane.

Note You can not change color of an Invalid Data (packet error) field. 
It is permanently set to red.

Changing Field Formats
To change field formats, select an item in the Group and Color pane.  This 
action enables the Formats radio buttons on the right.  The format types 
change with respect to the item selected under the Group and Color pane. 
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For example, select Display Units in the Group and Color pane as shown in 
Figure 6.4. The Formats radio buttons appear as shown in Figure 6.5. 

Figure 6.4 Group and Color Pane: Display Units Selected

Figure 6.5 Formats for Display Units

Hiding Fields
To hide one or more fields in the trace, select the appropriate item from the 
Group and Color pane, click the Hidden checkbox (Figure 6.6), and click 
the Save button.

Figure 6.6 Hidden Check Box

6.4 Saving Display Options 
To complete your display options settings, use the features at the bottom of 
the Display Options window. These features remain the same no matter 
which of the four Display Options windows you are working in.

• Click Save to save the currently specified display options for use in 
future sessions. Any file name can be specified, but you must use 
the .opt extension. If no extension is specified, .opt is added by 
default.
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• Click Load to load a previously saved *.opt file, thus restoring a 
previous set of display options.

• The Save as Default function is equivalent to the Save function, 
specifying the file name default.opt. Whenever you start up the 
Analyzer, it automatically loads the default.opt file if one exists.

• Click OK to apply any changes you have made to display options 
and close this dialog box.

• Click Cancel to cancel any immediate changes you have made and 
exit the Display Options menu.

• Click Apply to apply your changes while keeping the Display 
Options window open.
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7. Recording Options
This chapter describes how to use the Recording Options window.

7.1 Recording Options Overview
You can use the Recording Options window to set recording features. The 
window has two tabs: the General tab and Misc. (miscellaneous) tab. Each 
tab brings up a separate page of the window. The pages are:
General: To set general recording characteristics, including buffer size, 
recording type, and Trace filename and path.
Misc: To set other recording characteristics.
To go to the Recording Options window:

Step 1 From the Setup menu, select Recording Options. 

Step 2 The Recording Options window appears (Figure 7.1). 

Fill out the various areas of the window as described in following 
sections.

Figure 7.1 Recording Options Window: General Page
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Note:  The settings you configure in the Recording Options window apply 
to all recordings made by the analyzer.

7.2 Recording Options: General
You set general options on the General page. The page has areas (boxes) for 
Recording Type, Options, Options Name, and Trace Filename and Path.

Recording Type
The Recording Type box presents three options that control how 
UWBTracer begins and ends a recording. The options are Snapshot, 
Manual Trigger, and Event Trigger:

Snapshot: A Fixed-length recording.  A Snapshot is a recording whose 
size is set via the Buffer Size box. Recording begins when the Start 

Recording button   is clicked and ends when either the selected buffer 
size is filled or the Stop Recording button  is pressed. 
Manual Trigger: A recording whose ending is triggered by pressing the 
Trigger button on the front panel.

Recording begins when the Record button  is pressed on the Tool bar. 
Recording continues in a circular manner within the limits set by the buffer 
size. Recording ends following depression of the Trigger button on the 
front panel.  Once the Trigger button has been pressed, recording continues 
until the post-trigger buffer has been filled or the Stop button   is 
clicked on the Tool bar.
Event Trigger: A recording whose ending is triggered by user-defined 

events. Recording begins when the Record button   is clicked on the 
Tool bar.  Recording continues in a circular manner within the limits set by 
the buffer size until a trigger event is detected and the defined amount of 
data has been recorded after the Trigger event.

Note:  Please see the Readme file on the software installation CD for the 
most current information on triggering support.

Options
The options checkboxes appear on the upper right side of the Recording 
Options window.

Beep When Trigger Occurs: When this checkbox is selected, the 
computer connected to the UWBTracer beeps three times when a Trigger 
condition is first detected.
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Save External Interface Signals: Records signals from data pins on 
breakout board.

Buffer Size
In a recording, the entire trace is recorded and stored in the analyzer buffer 
before it is uploaded to the host PC.  Recordings are thus limited in size to 
the size of the analyzer buffer. 
The Buffer Size slide bar adjusts the recording buffer size from 1.6 MB to 
2048 MB (Figure 7.2).

Figure 7.2 Recording Options Window: Buffer Size Slider

Trigger Position
The Trigger Position slide bar sets the amount of pre- and post-trigger 
recording (Figure 7.3). You also can use it to adjust the location of the 
trigger within the defined buffer. You can adjust the triggering position 
between 1 and 99% post-Trigger. Trigger Position is available only when 
you select Manual Trigger or Event Trigger as recording type.

Figure 7.3 Recording Options Window: Trigger Position Slider

As an example, if the buffer size is set to 16MB, then for the following 
Trigger Position settings, the amount of pre- and post-Trigger data is

• 95% post-triggering: 0.8MB pre-trigger, 15.2MB post-trigger
• 75% post-triggering: 4MB pre-trigger, 12MB post-trigger
• 50% post-triggering: 8MB pre-trigger, 8MB post-trigger 
• 25% post-triggering: 12MB pre-trigger, 4MB post-trigger
• 5% post-triggering: 15.2MB pre-trigger, 0.8MB post-trigger
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Note:  When a Trigger occurs, recording continues until the post-Trigger 
amount of the buffer is filled.

Options Name
You can save the recording options to an options file. The file is stored in 
the same directory as the application. To save as an options file, press the 
Save button. A dialog box comes up that lets you name the file (a .rec 
extension is appended automatically).

When you launch the UWBTracer application, by default it loads the 
recording options file named default.rec. To save your options as the 
default file, press the Save as Default button.

Trace Filename and Path
This allows you to set the name of the trace file and the location where the 
file is stored.

7.3 Recording Options: Miscellaneous
You set miscellaneous recording options on the Misc. page (Figure 7.4). 
Currently that page has checkboxes for two options.

Debug
Select the checkbox to generate an additional binary file at the end of 
recording. The file is stored in the root (c:\) directory. The file name is 
BusEngineRawTracexxxx.dot, where xxxx is the serial number of the 
analyzer. The file is useful if you want to report a problem to LeCroy 
Technical Support and are asked to provide additional information.

Advanced
Click the Advanced button to go to the advanced settings window. This 
window holds recording settings that should not be modified in most cases. 

Note:  Currently, this window only contains one setting, the sample 
timing for capturing data.

Capturing: By default, trigger is set to occur on the negative edge of the 
PCLK clock pulse. If the recording data is corrupted, you might want to 
uncheck this box, which sets trigger to occur on the positive edge of the 
PCLK clock pulse instead.
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Figure 7.4 Recording Options Window: Miscellaneous Page

Figure 7.5 Recording Options Window: Advanced 
 45



 UWBTracer User ManualLeCroy SW Version 1.10
7.4 Recording Options: Recording Rules
Use the Recording Rules page to set triggers and filters. The page has the 
following areas (Figure 7.6):

Toolbar: Contains buttons that control the Recording Rules page.

Available Events Area: Area where you can park Event buttons that you 
intend to use in the Main Display area.

Main Display Area: Area where you configure trigger and filter rules. You 
configure rules by dragging Event buttons from the Available Events area 
and then assigning actions to those buttons. 

Config Status Indicator: A button that indicates if the rule is valid or 
invalid. If a trigger or filter rule is configured correctly, the button is green 
and indicates Config is Valid. If a rule is not configured correctly, the button 
is red and indicates Config is Invalid.

Pop-Up Menus (not shown): When you right-click a button or area in the 
Recording Rules page, a context-sensitive pop-up menu appears that lets 
you do operations that relate to that button or area.

Figure 7.6 Recording Options Window: Recording Rules Page

Tool bar

Available
Events
Area

Main
Display
Area

Config
Status
Indicator 
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Recording Rules Toolbar
The Recording Rules toolbar has buttons that let you control the Recording 
Rules page (Figure 7.7 and Table 7.1).

Figure 7.7 Recording Rules Toolbar

1. If you have wheel mouse, you can also zoom by holding down the CTRL key and then operating 
the mouse wheel.

Recording Rules Page: How It Works
You can think of the Recording Rules page as a workspace for creating 
recording rules (rules that determine how the analyzer records traces). 
Recording rules are combinations of events and actions. 

In UWBTracer terms, an event and the action or actions associated with it 
form a rule state. One or more states are encapsulated in a sequence.

Note:  There can be from one to 512 states within a sequence. You can 
associate one or more events with each state, and you assign each event 
a different action or the same action. 

Table 7.1  Recording Rules Toolbar Buttons

New Event. Creates a new 
event in the Available Events 
area.

Zoom Out. Makes the 
display appear smaller.

Delete Event. Deletes the 
selected event.

Show/Hide Channels. 
Shows or hides the channel 
icon on the Event button.

Undo. Undoes the change 
made to Recording Rules 
page. The Undo buffer has 
unlimited size.

Show/Hide Properties 
Dialog. Shows or hides the 
properties dialog of the 
selected event, action, or 
state.

Redo. Restores changes done 
to the Recording Rules page.

This display appears when 
the current Recording 
Rules configuration can be 
executed by the hardware.

Zoom In. Enlarges the 
display1. There are five 
zoom levels. The default 
level is the middle one.

This display appears when 
the current Recording 
Rules configuration can 
not be executed by the 
hardware.
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A sequence that has only one state is called a single-state sequence. The 
analyzer continuously watches for each event in the sequence and executes 
the corresponding action if the event is detected.
A sequence that has multiple states is a multi-state sequence. The states are 
arranged in a hierarchy, with a top state and successively lower states. Only 
one state in a multi-state sequence is active at a time. The analyzer does not 
go to a successive state unless it is directed to do so by the previous state.
Sequences are described in detail in "Using Sequences," later in this chapter.
Briefly, creating a rule involves the following steps:
Step 1 Creating Event buttons in the Available Events area.
Step 2 Drag-and-drop of Event buttons to the appropriate areas 

(cells) in the Main Display area.
Step 3 Assigning an action or actions to each Event button.

Creating Event Buttons
To create a rule, you start by creating one or more Event buttons. As you 
create Event buttons, they appear in the Available Events area. You then can 
drag-and-drop them into the Main Display area.
The following steps summarize the process:
Step 1 Click the New Event button at the left side of the toolbar. A 

New Event pop-up menu appears (Figure 7.8).

Figure 7.8 Creating a New Event
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Step 2 Select the event from the pop-up menu (Figure 7.9). The 
event appears in the Available Events area (Figure 7.10).

Figure 7.9 Selecting Event Type

Figure 7.10 Event Button Appears in Available Events Area

Dragging a Button to the Main Display Area
After you create an Event button in the Available Events area, you can drag 
the button to the Main Display area and drop it in the appropriate cell (a cell 
is a grayed-out rectangle with a dashed line around it). You can think of each 
cell as a target for drag-and-drop of an Event button.

There are two types of cell that might appear: Sequence cell and state cell. 
In the Main Display area, they are labelled as follows:

• Sequence cell: "Drag an event here to add a new sequence."
• State cell: "Drag an event here to add another state."

If there currently are no events in the Main Display area, a single sequence 
cell appears at the top of the area (Figure 7.10). 
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To drag-and-drop the Event button:

Step 1 Place the mouse cursor on the Event button in the Available 
Events area. Click the left mouse button.

Step 2 Drag the button to the cell. When the button is in the cell, a 
dashed highlight line appears around the cell (Figure 7.11). 
Drop the button in the cell (release the left mouse button).

Step 3 The Event button appears in the cell (Figure 7.12).

Figure 7.11 Drag-and-Drop Event Button to Cell

Figure 7.12 Event Button in Cell

As shown in Figure 7.12, the default label for the first cell is "Sequence 0, 
State 1." As described later in this section, you can change that label using 
the Properties pop-up for that cell. 

As Figure 7.12 also shows, two new cells appear under the first cell. The 
first of these new cells is a state cell that allows you to create another state 
in rule Sequence 0 (to make Sequence 0 a multi-state sequence).
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The second of the new cells is to create a separate sequence, which would 
be labelled Sequence 1.

Assigning an Action
After you have dropped the Event button in a cell in the Main Display area, 
you can assign an action to the event.  

Note If you do not assign an action to an Event button, the analyzer 
ignores the event.

To assign an action to an Event button:

Step 1 Right-click on the Event button. A pop-up menu appears 
(Figure 7.13).

Step 2 Select Specify Action, and then choose an action from the 
submenu. The menu closes, and the action is assigned 
(Figure 7.14).

Figure 7.13 Selecting Action From Event Button Pop-Up

Figure 7.14 Action Assigned to Event
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Note You can also set actions within the Properties dialog for each event.  
Double-click on the Event button to open the Properties dialog, then 
select the Actions tab and set your actions.

Recording Rules Pop-Up Menus
The Recording Rules window has context-sensitive pop-up menus that are 
associated with the following types of object: cells, events, actions.

Cell Pop-up Menu
If you click on a cell in the Main Display area that has an Event button 
contained in it, the Cell pop-up menu appears (Figure 7.15).

The Cell pop-up menu has the following options.

New Event: Brings up the same menu that you get when you click the New 
Event button on the toolbar.

Properties: Brings up the Properties dialog for the selected cell.

Figure 7.15 Sequence Pop-Up Menu
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Action Pop-up Menu
If you click on an Action button in the Main Display area, the Action pop-up 
menu appears (Figure 7.16). 

The Action pop-up menu has the following options.

Trigger: Sets or clears Trigger action.

Filter In: Sets or clears Filter In action.  If Filter In is set, you can not use 
Filter Out (it is disabled).

Filter Out: Sets or clears Filter Out action.  If Filter Out is set, you can not 
use Filter In (it is disabled).

Note:  Examples that show use of filters are provided later in this chapter.

Figure 7.16 Action Pop-Up Menu

Advance the Sequence: Creates an event sequence consisting of the event 
you clicked on and an event in a successive state of the sequence.  A thick 
arrow appears from the selected event and points downward. 

In other words, the Advance the Sequence button is the link between two 
states in a multi-state sequence. The Advance the Sequence arrow tells the 
analyzer to go to the next state if it detects the event at the tail (origin) of the 
arrow.
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Figure 7.17 Advance the Sequence

Restart the Sequence (not shown): Restarts the sequence.  Note that this 
option is context-sensitive and only appears if you have created a multi-state 
sequence.  A thick arrow appears from the selected event and point upward 
towards the first event in the sequence.

Restart All: Restarts all rules in all sequences and in the global state.  When 
you select this option, an arrow and Restart All button will appear.  This 
action precludes selecting Advance the Sequence and Restart the Sequence.

External Trigger Pulse HIGH: Sends an output signal with a Pulse High 
format through the output ports on the back of the UPAS.  Pulse High is the 
default format.  Pulse High causes the analyzer to transmit a 5 volt, 40 
nanosecond signal.

External Trigger Pulse LOW: Sends an output signal with a Pulse Low 
format through the output ports on the back of the UPAS.  Pulse Low causes 
the analyzer to transmit a 0 volt, 40 nanosecond signal.

External Trigger Pulse TOGGLE: This format causes the analyzer to 
transmit a signal that will toggle with each trigger event between a 
continuous 5 volt signal and a continuous 0 volt signal.

Properties: Displays the Action Properties dialog for the selected action.
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Event Pop-up Menu
If you click on an Event button in the Main Display area, the Event pop-up 
menu appears (Figure 7.18). 

Figure 7.18 Event Pop-up Menu

The Event pop-up menu has the following options.

Specify Action(s): Opens the Actions submenu, allowing you to assign an 
action to the event. Options on this submenu are the same as those on the 
Action pop-up, described previously.

Add Counter: Adds a counter to count a specified number of times the 
event occurs before the analyzer executes the corresponding action.

Move Event to: Moves the selected event to a different position in the 
Recording Rules window.

Copy Event to: Copies the selected event to a different position in the 
Recording Rules window.

Delete This Event: Deletes the selected Event.  Alternatively, you can use 
the Delete button on the toolbar or keyboard to delete events.

Properties: Displays the Event Properties dialog for the selected event.
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Events and Event Properties
Recording rules are associations between events and actions. These 
associations determine how trace recording occurs.

Table 7.2 lists UWBTracer supported events.
Table 7.2  UWBTracer Events

Event Description

MPI Bus States Occurrence of state transitions in the PHY.
MPI Serial Data Occurrence of serial data passed between MAC and PHY.
MPI Errors Occurrence of RX frame errors, aborted frames, FCS, errors, or length 

mismatch.
MPI Conditions Occurrence of empty frames.
WiMedia Frame Occurrence of a customizable frame pattern.
WiMedia Frame Type Occurrence of specified WiMedia frame type: Beacon, Control, 

Command, Data, Aggregated Data.
WiMedia Control Frame Occurrence of specified WiMedia Control frame: Imm-ACK, B-ACK, 

RTS, CTS, UDA, UDR, App Specific.
WiMedia Command Frame Occurrence of specified WiMedia Command frame:

DRP Rsv Req, DRP Rsv Resp, Probe, PTK, GTK, Range, App Specific.
WUSB Device Notification Occurrence of specified WUSB Device Notification:

DN_Connect, DN_Disconnect, DN_EPRdy, DN_RemoteWakeup, 
DN_MASAvailChanged, DN_Sleep, DN_Alive.

WUSB MMC Packet Occurrence of WUSB MPC packet.
WUSB Data Packet Occurrence of WUSB Data packet.
WUSB Host/Addr/Endp/Dir Occurrence of any combination of the following fields: HOST, ADDR, 

ENDP, DIR.
WUSB PID Occurrence of DATA, IDATA, HNDSHK, DN.
WUSB ACK Code Occurrence of ACK, NAK, STALL.
Breakout Board Data Occurrence of signal on breakout board data pins.
Timer Occurrence of timer expiration.
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Actions and Action Properties
Table 7.3 lists UWBTracer supported actions.

Using a Single-State Sequence
As described previously, a sequence can be single-state or multi-state. A 
single-state sequence is a simple combination of events and actions. You 
can not create looping or branching conditions with this type of sequence. 

A multi-state sequence allows you to branch successively to (advance to) 
lower states in the sequence or to loop to the front of the sequence (restart 
the sequence). 

Following are four typical examples of single-state sequences. 

Example 1: Creating a Simple Event Trigger
In this example, recording is triggered by detection of a WUSB ACK code.

Step 1 Click the New Event button. From the drop-down menu, 
select WUSB ACK Code > ACK (Figure 7.19).

Step 2 An ACK Event button appears in the Available Events area.

Step 3 Drag the button to the sequence cell at the top of the Main 
Display area.

Step 4 Right-click on the button. From the Action pop-up menu, 
select Trigger (Figure 7.20).

Figure 7.21 shows the completed event-action sequence.

Table 7.3  UWBTracer Actions

Event Description

Trigger Start recording.
Filter In Include in the trace file the event specified (and no others).
Filter Out Exclude from the trace file the event specified.
Advance the Sequence Go to the next state in this sequence.(sequence in which this action is 

located).
Restart the Sequence Restart this sequence (sequence in which this action is located).
Restart All Restart all sequences.
External Trigger Pulse HIGH Send HIGH pulse on external trigger output.
External Trigger Pulse LOW Send LOW pulse on external trigger output.
External Trigger Pulse TOGGLE Send HIGH-LOW pulse on external trigger output.
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Figure 7.19 Example 1: Creating the Event

Figure 7.20 Example 1: Assigning the Action
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Figure 7.21 Example 1: Complete Rule

Example 2: Creating an Event Counter
In addition to setting triggers and filters, you can set counters. A counter is 
an action that lets you set a trigger based on a count of events. To continue 
the previous example, for instance, you can create a rule that triggers on the 
tenth occurrence of a WUSB ACK.
Step 1 From example 2, the ACK is configured as the first event in 

the state (Figure 7.21).
Step 1 Right click on the ACK event button in the cell. The Event 

pop-up menu appears.
Step 2 From the Event pop-up menu, select the Add Counter option 

(Figure 7.22). 
The Event properties dialog box appears (Figure 7.23). As shown in 
Figure 7.23, the set counter box is at the lower left (see cursor).

Figure 7.22 Example 2: Adding a Counter
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Figure 7.23 Example 2: Setting the Counter

Step 3 By default, the counter box is set to a value of 2. For this 
example, reset the box to 10. 

Step 4 Close the Event properties dialog box. The counter value 10 
now appears in the ACK Event button (Figure 7.24). The 
trigger occurs after the analyzer detects the tenth occurrence 
of an ACK.

Figure 7.24 Example 2: Complete Rule

Example 3: Creating an OR Condition
When you assign two or more Event buttons in state cell to the same action, 
the analyzer watches for all the events and does the action for the event that 
the analyzer sees first. Neither event has precedence over the other.There is 
a logical OR association among the events.
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The following example assumes you want to trigger when the analyzer 
detects a WUSB NAK or the tenth occurrence of a WUSB ACK.

Step 1 From example 3, the ACK with counter is configured as the 
first event in the state (Figure 7.24).

Step 1 Click the New Event button. From the drop-down menu, 
select WUSB ACK Code > NAK.

Step 2 An NAK Event button appears in the Available Events area. 
Drag the button to the first cell and drop it below the ACK 
button (Figure 7.25).

Step 3 Right-click on the NAK button. From the Action pop-up 
menu, select Trigger (Figure 7.26).

Figure 7.27 shows the completed event-action sequence.

Figure 7.25 Example 3: Creating a Second Event
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Figure 7.26 Example 3: Assigning the Action

Figure 7.27 Example 3: Complete Rule

Example 4: Creating an Event Filter
A filter causes the analyzer to filter in or filter out specified events from the 
recording. By default, all events are filtered in. However, you might want to 
preserve recording memory so that you can extend recording session time. 
To do so, you can filter out events that do not interest you (or filter in only 
those events that interest you). 
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Note:  Keep in mind that when you filter out events, they are not recorded 
in the trace file. It is not the case that the events are present in the file but 
hidden.

The following example assumes you want recording to occur only if the 
analyzer detects an MPI error.

Step 1 Click the New Event button. From the drop-down menu, 
select MPI Errors to create an MPI Errors button in the 
Available Events area.

Step 1 Drag-and-drop the MPI Error button into the first cell in the 
Main Display area.

Step 2 Right click in the Action box to the right of the MPI Error 
button. The Action pop-up menu appears (Figure 7.28).

Step 3 From the Action pop-up menu, select the Filter In option.

Recording is now set to only record frames with MPI errors 
(Figure 7.29).

Figure 7.28 Example 4: Assigning the Action
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Figure 7.29 Example 4: Complete Rule

Using a Multi-State Sequence
Multi-state sequences allow you to create conditions that branch down to 
successive states or loop back to the beginning of the sequence. They are 
more complex than single-state sequences but very powerful.

Example 5: Creating a Looping Sequence
Following is a typical example of a multi-state sequence. In this example, 
the analyzer waits for a WUSB Data packet (first state). When it detects a 
Data packet, the analyzer waits for a corresponding ACK packet and starts 
a timer (second state). 

If an ACK is received before the timer expires, the sequence restarts. If an 
ACK is not received before the timer expires, recording is triggered.

Step 1 Click the New Event button. From the drop-down menu, 
select WUSB PID > DATA to create a Data button in the 
Available Events area.

Step 1 Drag-and-drop the Data button into the first cell in the Main 
Display area.

Step 2 Right click in the Action box to the right of the Data button. 
The Action pop-up menu appears (Figure 7.30).

Step 3 From the Action pop-up, select Advance the Sequence.

Step 4 An arrow appears next to the Data button (Figure 7.31). The 
arrow points to the cell for the second state in this sequence.

Step 1 Click the New Event button. From the drop-down menu, 
select Timer to create a Timer button in the Available Events 
area (Figure 7.32).

Step 1 Drag-and-drop the Timer button into the second cell in the 
Main Display area (Figure 7.33).
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Figure 7.30 Example 5: Advancing the Sequence

Figure 7.31 Example 5: First State Complete
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Figure 7.32 Example 5: Creating an Event, Second State

Figure 7.33 Example 5: Dragging to the Second State Cell

Step 2 Right click on the Timer event to open its properties dialog 
Box (Figure 7.34).

Step 3 In the properties dialog box for the timer, set the timer to 100 
microseconds (Figure 7.35).
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Figure 7.34 Example 5: Bringing Up the Timer Dialog Box

Figure 7.35 Example 5: Setting the Timer
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Step 1 Click on the New Event button. From the drop-down menu, 
select WUSB ACK Code > ACK to create an ACK button in 
the Available Events area (Figure 7.36).

Step 1 Drag-and-drop the ACK button into the second cell in the 
Main Display area.

Step 2 Assign Restart the Sequence as the action for the ACK event. 
An arrow appears that points from the ACK back to the Data 
event.

Figure 7.36 Example 5: Creating Another Event, Second State

Figure 7.37 Example 5: Complete Rule
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Using Independent Sequences
UWBTracer supports up to two independent sequences. By default, they are 
labeled Sequence 0 and Sequence 1. 

The two sequences operate in parallel and have no effect on each other with 
the following exception: Either of the two sequences can contain the action 
"Restart all." This action restarts both sequences in the Main Display area.

Example 6: Creating Independent Sequences
The following example adds a second sequence to the Example 6. The 
second sequence triggers recording if any MPI error is detected.

In this example, there are two conditions that trigger recording: the first 
condition is defined by sequence 0. The second condition is defined by 
sequence 1.

Figure 7.38 Example 6: Two Independent Sequences
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8. Reading Traces
This chapter describes how to read and manipulate trace displays. 

8.1 Trace Display Overview
UWBTracer trace viewing software  makes extensive use of color and 
graphics to fully document the captured (decoded) traffic (Figure 8.1).  

Frames are shown on separate time-stamped rows, with their individual 
fields both labeled and color coded. You can collapse data fields to save 
space in the display, and you can zoom in and out in the display. Pop-up 
Tool Tips annotate  fields with detailed information about their contents.

The display software can operate independently of the hardware and so can 
function as a stand-alone trace viewer that may be freely distributed.

Figure 8.1 Trace Display Example

8.2 Trace Level Views
You can display traces in any of four views: 

• MPI Frame-Level view (MPI). 
• WUSB Packet-Level view (PKT). 
• WUSB Transaction-Level view (TRA).
• WUSB Transfer-Level view (XFR).

MPI Frame-Level view is the default display.

Changing Trace Level Views
To switch between the Frame, Packet, Transaction, and Transfer views, 
click the respective buttons on the Tool bar (Figure 8.2).
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Figure 8.2 Trace View Buttons

Frame Level
The MPI Frame-Level view is the default decode level.  It displays traffic as 
shown in (Figure 8.3).

 

Figure 8.3 Trace View: MPI Frame Level

Packet Level 
Click the PKT button to show the WUSB Packet-Level view. The packet 
level is decoded and presented as shown in (Figure 8.5).  To see packet-level 
transactions, you may need to scroll through the trace or use the Find 
command (under Search). 

Figure 8.4 Trace View: WUSB Packet Level

Transaction Level
Click the TRA button to show the WUSB Transaction-Level view. The 
transaction level is decoded and presented as shown in (Figure 8.5).  To see 
transaction-level transactions, you may need to scroll through the trace or 
use the Find command (under Search).
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Figure 8.5 Trace View: WUSB Transaction Level

Transfer Level
Click the XFR button to show the WUSB Transfer-Level view. The transfer 
level is decoded and presented as shown in (Figure 8.6).  To see 
transfer-level transactions, you may need to scroll through the trace or use 
the Find command (under Search). 

Figure 8.6 Trace View: WUSB Transfer Level
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9. Searching Traces
This chapter describes how to search for trace events.

9.1 Trace Search Overview
UWBTracer has several search commands that let you navigate a trace view 
to search for key events, such as errors and triggers. The commands are on 
the Search menu (Figure 9.1).

To view the search options, click Search in the Menu bar.

Figure 9.1 Search Menu

9.2 Go to Trigger
To display a trigger event, select Go to Trigger from the Search menu.

The trace view is repositioned with the first frame following the trigger 
event (or the frame that caused the trigger) at the top of your screen.

9.3 Go to PLCP/Packet/Transaction/Transfer...
To display a specific frame or decode level, follow these steps:

Step 1 From the Search menu, select 

Go to PLCP/Packet/Transaction/Transfer... 
The corresponding dialog box appears (Figure 9.2).
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Figure 9.2 Go To PLCP/Packet/Transaction/Transfer Dialog Box

Step 2 Use the dialog box drop-down lists and text box, identify the 
feature you want to find.

Step 3 Click OK.

The trace view is repositioned with the selected item at the top of 
your screen.

9.4 Go to Marker
To instruct the analyzer to display a marked frame, follow these steps:

Step 1 From the Search menu, select Go to Marker (Figure 9.3).

Figure 9.3 Selecting Go to Marker

Step 2 Select the desired frame from the list displayed.  

The Trace View is repositioned with the selected item at the top of 
your screen.
Selecting Search > Go to Marker > All Markers will cause a 
dialog box to open with a list of all markers in the trace.  The dialog 
box offers options for editing, deleting, and copying markers.
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Note The Go to Marker feature functions in conjunction with the Set 
Marker feature. The comments within the parentheses 
following each marked Frame are added or edited with the Set 
Marker feature. 

9.5 Go to
The Go to feature takes you directly to an item in the trace. When you select 
Go to, a drop-down menu appears that allows you to select the item.

9.6 Find
Find is a utility that allows you to conduct searches of one or more events in 
a trace. Find allows you to search for different hierarchical levels within the 
trace: the MPI frame level, WUSB packet level, WUSB transaction level, 
and WUSB transfer level.
Select Find... under Search on the Menu bar
or
Click  in the Tool Bar.
You see the User-Defined Find Events window (Find Window) (Figure 9.4).

Areas in Find Window
The Find window has three areas: Event Groups pane, a context area to the 
right of the Event Groups pane (whose contents vary depending on items in 
the pane), and a Direction/Origin area at the right in the window.

Event Groups Pane: Left area that allows you to specify the events to find 
in the search. You can select as many check boxes as desired (for multiple 
search events). You also can combine specified event groups, meaning you 
can use logical relationships in your search: OR, AND, and NOT.

Union: OR relationship. The Find operation will search for frames 
that include any of the items selected in the Event Groups pane.
Intersection: The Find operation will search for only those frames 
that match all the items selected in the Event Groups pane.
Exclusion: NOT relationship. The Find operation will search for 
frames that do not match any of the items selected in the Event 
Groups pane.
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Figure 9.4 Find Events Window

Context area: Provides further selection criteria for the Event Group active 
in the Event Groups pane. For example, in Figure 9.4, the MAC Destination 
Addresses Event Group is currently active (selected). The context area lets 
you select a range of MAC addresses. In Figure 9.5, the PHY Data Rates is 
the active Event group. A different display appears in the context area.
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Figure 9.5 Find Events Window: MPI Bus States Active

Direction/Origin
The radio buttons and check boxes in the right part of the Find window let 
you specify where you want to start the search and search direction.

Direction: You can search forward or backward in the file.

Origin: You can choose the point-of-origin for the search.

Find All: You can find every instance of the search criteria.

Search in Hidden: You can search in frame elements that are hidden in the 
display as well as frame elements that are visible.
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10. Reports
This chapter describes how to use the Report menu. 

10.1 Trace Reports Overview
You bring up the Report menu from the application Main menu. The Report 
menu provides several reports to assist you in analyzing traffic recorded by 
the analyzer.  Those reports include:

File Information: To view general information about the trace file.

Traffic Summary: To view a summary of protocol-related information in 
the trace file summary information about a selected group of items in the 
trace file (such as a count of particular frame or packet types).

Error Summary: To view a count of errors in a trace file.

Timing Calculations: To view timing measured between two markers or 
counters set within the trace file.

.

Figure 10.1 Report Menu

10.2 File Information
To view general information about the trace file, select Report >File 
Information from the Report menu. A File Information window appears, 
showing the information (Figure 10.2).
The File Information window provides general information about the 
recording, such as when it was made and the version of the analyzer 
firmware and BusEngine used. 
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Figure 10.2 File Information Window

The window also has a link to the Recording Options settings used to create 
the trace. The link is marked with the text Open Recording Options in a 
dialog.  Clicking the link opens the Recording Options window and shows 
the settings used to create the trace.
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10.3 Traffic Summary
To view a summary of protocol-related information in the trace file, select 
Report >Traffic Summary from the Report menu. A Traffic Summary 
window appears, showing the information (Figure 10.3).

The traffic summary window has two panes. The left pane is a tree view of 
the protocol items you can select for the summary. The right pane shows the 
summary itself, in most cases a count of occurrences of the selected item.

Figure 10.3 Traffic Summary Window

Traffic Summary Buttons
The Traffic Summary toolbar provides a shortcut to commands that control 
the traffic summary (Figure 10.4). 

You can learn the function of each tool bar button by passing the mouse 
cursor over the button. A tool tip appears above the button, describing its 
function.

Table 10.1 describes the Traffic Summary buttons.

Figure 10.4 Traffic Summary Toolbar
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Using the Traffic Summary
To use the traffic summary window, you need to know how to select the 
items for which you want a summary, to set a range for the summary, and to 
use navigational features.

Selecting Traffic Summary Items
As described, you use the left pane of the Traffic Summary window to select 
the item for which you want to show a summary in the right pane.

For example, suppose you want to show the count of all MPI Frames in the 
trace. To do so, select MPI frames in the left pane (Figure 10.5). A count of 
the number of MPI frames appears in the right pane. In this example, there 
are three MPI Control frames and three MPI Data frames.

Figure 10.5 Selecting an Item for the Traffic Summary

You can select multiple items in the left pane, each resulting in a separate 
summary in the right pane (the summaries follow each other sequentially) 
(Figure 10.6). To select more than one item, hold down the CTRL key as 
you select items in the left pane.

Table 10.1  Traffic Summary Buttons

Save. Saves the traffic summary to a 
file in HTML format.

Text. Displays the traffic summary in text 
format.

Email. Sends the traffic summary in 
HTML format via an email.

Options. Opens a menu that allows you to 
set the way trace file items are counted for 
the traffic summary.

Print. Prints the traffic summary. Select Range. Sets a range of items to be 
counted in the trace file.
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Figure 10.6 Selecting Multiple Items for the Traffic Summary

Setting Traffic Summary Display Options
You can control the appearance of the traffic summary display using the 
Options button on the Traffic Summary tool bar. When you click on the 
button, the Options drop-down menu appears (Figure 10.7).
Grid Lines: Enables/disables grid lines to the display.
Tight Columns: Enables/disables narrow columns in the display
Row Selection: Enables/disables row highlighting in the right pane.
Event Navigation: Brings up a menu that allows you to set parameters for 
using traffic summary to navigate in the trace (trace navigation is described 
later in this section) (Figure 10.8). 
In the Event Navigation menu, the Skip hidden items option means you can 
not navigate to hidden items in the trace. Show hidden items means if you 
navigate to a hidden item, the item will appear in the trace (be shown for 
purposes of the navigation). Prompt each time means you can navigate to 
a hidden item, but UWBTracer will prompt you to indicate whether or not 
you want the item to appear in the trace.
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Figure 10.7 Traffic Summary Options Menu

Figure 10.8 Event Navigation Submenu

Setting Traffic Summary Range
You can select a range within the trace file for which items are displayed in 
the traffic summary. All occurrences of the item outside of the range are not 
included in the summary. You can set the range with respect to particular 
frame or packet types. Your choice of these types is context-sensitive and is 
determined by the current trace decode level (MPI trace level view, WUSB 
packet level view, and so on).

In the following example, suppose you have trace decode level set to WUSB 
packet level view and suppose the trace contains six MPI frames. To collect 
statistics from the third through fifth MPI frames (inclusive), do these steps:

Step 1 With the trace file open, select Traffic Summary from the 
Report menu (or click on the Traffic Summary button on the 
Main tool bar). The Traffic Summary window appears.
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Step 2 Select MPI frames in the left pane of the Traffic Summary 
window. The summary for MPI frames appears in the right 
pane.

Step 3 Click on the Select Range button on the Traffic Summary 
tool bar (Figure 10.9).

Step 4 The Select Range dialog box appears (Figure 10.10).

Figure 10.9 Selecting Traffic Summary Range

Figure 10.10 Select Range Dialog Box

Step 5 In the Select Range dialog box, MAC-PHY Interface (MPI) 
Frame as the protocol unit for which you are going to set 
range. Enter 3 as the start point of the range (Figure 10.11).

Step 6 The Traffic Summary window now shows statistics for MPI 
frame 3 through MPI frame 5 of the trace (Figure 10.12).
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Figure 10.11 Setting Range to Start on Third Frame

Figure 10.12 Traffic Summary for Three MPI Frames

Using the Display to Navigate Within the Trace File
You can use the Traffic Summary window to navigate to a specific frame or 
packet in the trace file. For example, suppose you want to go to the second 
MPI Data frame. To do so, follow these steps:

Step 1 With the trace file open, select Traffic Summary from the 
Report menu (or click on the Traffic Summary button on the 
Main tool bar). The Traffic Summary window appears.

Step 2 Select MPI frames in the left pane of the Traffic Summary 
window. The summary for MPI frames appears in the right 
pane.

Note:  In this example, the trace contains three MPI Control frames and 
three MPI Data frames.

Step 3 Click on the count in the total column for Data frames 
(Figure 10.13). 
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Step 4 The Go box becomes active at the top of the right pane 
(Figure 10.14). By default, it is set at the first MPI Data 
frame (MPI 1, shown at the top in the trace). 

Step 5 In the Go box, enter 2 to indicate that you want to go to the 
second MPI Data frame in the trace (Figure 10.15). When 
you do so, the trace display adjusts so that the second MPI 
Data frame appears at the top of the display (MPI 3, shown 
at the top of the trace (Figure 10.16)).

Figure 10.13 Selecting the Row for Data Frames

Figure 10.14 First MPI Data Frame at Top of Display
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Figure 10.15 Set Go Box to Second MPI Data Frame

Figure 10.16 Second MPI Data Frame at Top of Display

10.4 Error Summary
To view a count of errors in the trace file, select Report >Error Summary 
from the Report menu (or click on the Error Report button on the Main tool 
bar). The Traffic Summary window appears. The right pane is set to display 
error count (Figure 10.17).

Note:  The types of errors that are displayed is static (you can not change 
the types of errors to be included in the summary).
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Figure 10.17 Error Summary Display

Note:  The types of errors included in the summary are static (you can not 
change the types of errors that are reported on).

10.5 Timing Calculations
The timing calculator measures timing between any two specified frames. 
To run the Timing Calculator:
Step 1 From the Report menu, select Timing Calculations.
Step 2 Select the range, and click the Calculate button.  The results will 

then display in the window.
 

Figure 10.18 Timing and Bus Usage Calculator

10.6 Real-Time Statistics
To display a summary of the occurrence of various types of protocol units 
in a trace file, select Report >Traffic Summary from the Report menu. A 
Traffic Summary window appears, showing the traffic data (Figure 10.3).

The Real-Time Statistics window provides information on links activity in 
real-time (Figure 10.19). The window has two areas:

Graph Area (left side of window): Provides graphs that show occurrences 
of particular frames, errors, and events. 
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General Statistics Area (right side of window): Provides displays that 
show signal strength, link quality, number of frames, and signal status. All 
data that is displayed is calculated as averages over a sampling period.

The window can display information from multiple analyzer devices. You 
toggle displays for each device by clicking on tabs in the General Statistics 
area.

For example, as shown in Figure 10.19, the SN566 tab is selected. The 
display currently shows information for the SN566 device. To switch the 
display to information for the SN567 device, click on the SN567 tab.

Figure 10.19 Real-Time Statistics Window

The Real-Time Statistics window tool bar provides quick access to key 
functions of the window (Figure 10.20). You can learn the function of each 
tool bar button by passing the mouse cursor over it. A tool tip will appear 
above the button and the command name will appear in the Main window 
status bar.

Table 10.2 describes the Real-Time Statistics buttons.
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Figure 10.20 Real-Time Statistics Tool Bar

Graph Area
The graph area displays two graphs: Occurrences of frames and occurrences 
of errors. You can set the properties of each through a Graph Area Properties 
dialog box. To bring up the dialog box for either of the two graphs:
Step 1 Put the mouse cursor in the area of the graph and click the 

right mouse button. 
Step 2 A pop-up menu appears (Figure 10.21).
Step 3 Click on Properties to bring up the Graph Area Properties 

dialog box for that graph.

Table 10.2  Real-Time Statistics Toolbar Buttons

Save. Vertical Zoom out

E-mail "Click and Drag" Zoom Area

Print Synchronize Graph Areas

Full Screen Graph Areas

View Settings .Start Real-Time Statistics

Horizontal Zoom in Stop Real-Time Statistics

Horizontal Zoom out Reset Graphs and Counters Display

Vertical Zoom in
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Figure 10.21 Real-Time Graphs Pop-Up Menu

Graph Properties for Frame Occurrences
Figure 10.22 shows the Graph Properties dialog box for the Frame 
Occurrences graph. You can select from a variety of graphs that show 
statistics about different frame types.

The left side of the dialog box shows a list of graphs associated with each 
analyzer in the analyzer network (SN566, SN567 and so on). When you add 
a new analyzer to the analyzer network, a new set of graphs is added to the 
list.

Figure 10.22 Graph Area Properties for Frames

Graph Properties for Error Occurrences
Figure 10.23 shows the Graph Properties dialog box for Error Occurrences 
graph. There are two types of error graphs: Device-specific errors and 
general errors.
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Device-specific errors are errors that can be associated with specific UWB 
devices. The device-specific errors that you can monitor are:

PHY Payload Error
PHY Unsupported Rate

General errors are errors that can not be associated with specific UWB 
devices. The general errors that you can monitor are Header Errors.

Figure 10.23 Graph Area Properties for Errors

General Statistics Area
The right side of the Real-Time Statistics window shows the General 
Statistics area (Figure 10.24). It has the following displays:

Accumulators: A running count of total frames displayed during the 
statistics collection period.

RSSI By Device: A histogram that shows received signal strength for UWB 
devices for up to eight devices.

LQI By Device: A histogram that shows link quality for UWB devices for 
up to eight devices.

MPI Wire Activity: A visual display of the state of signals on the MPI bus. 

• Purple bar is signal high.
• Green bar is signal low.
• Red arrow marks that the signal toggled at least once during the last 

signal period.
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Figure 10.24 Real-Time Statistics Window: General Statistics Area
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11. Updates and Licensing
This chapter describes how to update to UWBTracer software and how to 
obtain a software license key from LeCroy. 

11.1 Updates Overview
From time to time as modifications are made to the UWBTracer Analyzer, 
it may become necessary to update the UWBTracer software.  You can 
obtain new software from the LeCroy website:  

www.LeCroy.com  
When you download new UWBTracer software, the most recent firmware 
and BusEngine files are included in the software package.  After software 
installation, you can compare the firmware and BusEngine version numbers 
against what is currently loaded on the analyzer. If those files do not match, 
you can download the latest versions using the manual or automatic process 
described later in this chapter.

Note: LeCroy analyzers include a Three Year Investment Protection 
Agreement that entitles users to new software during that period. 
To update software after that period, you must renew the LeCroy 
Maintenance Agreement. Contact LeCroy for details.

11.2 Software, Firmware, and BusEngine Versions
The Readme file on the installation CD and on the installed directory on 
your hard drive gives last-minute information about the current release. As 
mentioned, the software package for each release includes the most recent 
downloadable images of the firmware and the BusEngine. 

Once the UWBTracer Analyzer has completed the self diagnostics and is 
connected to the PC, you can check the latest version of the software and 
BusEngine.

To check information about the current software, select 
About UWBTracer… from the Help menu.

The About UWBTracer window appears (Figure 11.1).
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About UWBTracer details revisions of the following software and 
hardware:

• UWBTracer Software Version, Build Number
• UWBTracer Firmware Version
• BusEngine Version, Build Number
• Unit Serial Number

Note:  When contacting LeCroy for technical support, please have 
available all the revisions reported in the About UWBTracer window.

Figure 11.1 About UWBTracer Window

11.3 Software Updates
When a new software release is available, it is posted on the Support page 
of the LeCroy website at www.LeCroy.com/support.html.

To update the software:

Step 1 Find the latest released software version on the LeCroy website 
under Support.

If you are running the latest version of the software, no further 
action is needed. 
If you are not running the latest version, continue to Step 2.

Step 2 Download the Zip file from the website.

Step 3 Unzip the files into your choice of directory.
98



 UWBTracer User ManualLeCroy SW Version 1.10
Step 4 Click Start, then Run, and browse to where you unzipped 
the files.

Step 5 Select the program named Setup and click Open.

Step 6 Click OK to run the Setup and begin the installation.

Step 7 Follow the on-screen instructions to complete the 
installation.

Step 8 Read the Readme file for important information on changes 
in the release.

11.4 BusEngine and Firmware Updates
Often you need to update BusEngine and firmware files when you update 
the UWBTracer software. The software Readme file indicates if BusEngine 
or firmware update are necessary.

Note:  Within a new software release, it might also be necessary to update 
the BusEngine hardware of the analyzer. The Readme file lets you know 
if this is necessary. 

Automatic Update of BusEngine and Firmware
When you update UWBTracer software, the new version might not match 
(be compatible with) the BusEngine and firmware currently installed on the 
analyzer. As the software is loaded, it determines if there is a mismatch. If 
so, the software initiates automatic update of the firmware and BusEngine.

A dialog box appears to confirm that you want to proceed with the update. 
If so, click OK. The update is executed.

Manual Update of BusEngine and Firmware
You also can manually load firmware and BusEngine files using the Update 
BE/FW command on the Setup menu. To do so:

Step 1 From the Setup menu, select Update BE/FW.

Step 2 A dialog appears that allows you to select whether you want 
to update firmware, BusEngine, or both. Make your 
selection and click the Update button.

Step 3 A dialog box appears to confirm that you want to proceed 
with the update. If so, click OK. The update is executed.
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11.5 License Information
You can view license information for UWBTracer by selecting Display 
License Information from the Help menu. The License window indicates 
the maintenance expiration data for UWBTracer. It also provides a list of 
the named features supported by the current software version. 

Named features enabled on your PC are indicated by Yes in the Purchased 
column. Named features that are not enabled on your PC are indicated by 
No in the Purchased column. Whether or not named features are enabled 
depends on the license key stored in your analyzer.

Figure 11.2 License Window

11.6 Updating the Software License
A current license agreement with LeCroy entitles the analyzer owner to 
continued technical support and access to software updates as they are  
published on the LeCroy website. 

If your license expires, you must obtain a license key from LeCroy (refer to 
the contact information at the back of this manual.) 
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After you obtain a license key, follow these steps to install it:

Step 1 From the Help menu, select Update License. The Update License 
dialog box appears. 

Step 2 Enter the path and filename for the license key or use the Browse 
button to navigate to the directory that contains the license key. 

Step 3 Select the *.lic file, and then click Update Device.
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A. Specifications
The following specifications describe a combined UWBTracer™ MPI and 
Universal Protocol Analyzer System.

Package
Dimensions: UPAS 10000:

12.2 x 12.2 x 3.5 inches (31.1 x 31.1 x 8.9 cm)
UWBTracer MPI Plug-in: 
4.5 x 6.7 x 1.3 inches (11.3 x 17.0 x 3.2 cm)

Connectors: UPAS 10000:
UPAS AC power connection
External trigger connection (DB-25, BNC)
PC connection (USB2.0, type "B")
Break-out board (type "D")
UWBTracer MPI Plug-in:
MPI Adapter port

Weight: UPAS 10000:
9.5 lbs. (4.3 kg)
UWBTracer MPI Plug-in:
1 lb. 11 oz. (0.77 kg)

Power Requirements
90-254 VAC, 47-63 Hz, 100 W minimum (universal input)

Environmental Conditions
Operating Range: 0 to 40 °C (32 to 104°F)
Storage Range: -20 to 80 °C (-4 to 176°F)
Humidity 10 to 90%, non-condensing

Switches
Power: On/Off
Manual Trigger: When pressed forces a trigger event.
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Indicators (LEDs) - UPAS
Power (PWR): Illuminated during Power-On Self-Test (POST)
Recording (REC): Illuminated when the analyzer is actively recording 

    traffic data.
Triggered (TRG): Illuminated when the 40-pin input is in use.
Sync-ed (SYNC): Illuminated when the analyzer is synchronized to 

    the date.

Indicators (LEDs) - UWBTracer MPI Plug-In
Status: Illuminated when the analyzer in Slot 1 is recording.

Indicators (LEDs) - Cable Adapters
Power (POWER: Illuminated when power is provided to the adapter.
68 PIN INPUT: Illuminated when the 68-pin input is in use.
40 PIN INPUT: Illuminated when the 40-pin input is in use.

Recording Memory Size
2 GB for trace capture, timing, and control information.
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How to Contact LeCroy

Limited Hardware Warranty
So long as you or your authorized 
representative ("you" or "your"), fully 
complete and return the registration card 
provided with the applicable hardware product 
or peripheral hardware products (each a 
"Product") within fifteen days of the date of receipt from LeCroy or one of its 
authorized representatives, LeCroy warrants that the Product will be free from 
defects in materials and workmanship for a period of three years (the "Warranty 
Period").  You may also complete your registration form via the internet by visiting 
http://www.catc.com/support/register/.  The Warranty Period commences on the 
earlier of the date of delivery by LeCroy of a Product to a common carrier for 
shipment to you or to LeCroy's authorized representative from whom you purchase 
the Product.

What this Warranty Does Not Cover
This warranty does not cover damage due to external causes including accident, 
damage during shipment after delivery to a common carrier by LeCroy, abuse, 
misuse, problems with electrical power, including power surges and outages, 
servicing not authorized by LeCroy, usage or operation not in accordance with 
Product instructions, failure to perform required preventive maintenance, software 
related problems (whether or not provided by LeCroy), problems caused by use of 
accessories, parts or components not supplied by LeCroy, Products that have been 
modified or altered by someone other than LeCroy, Products with missing or altered 
service tags or serial numbers, and Products for which LeCroy has not received 
payment in full.

Type of Service Contact
Call for technical support… US and Canada: 1 (800) 909-2282

Worldwide: 1 (408) 727-6600
Fax your questions… Worldwide: 1 (408) 727-6622
Write a letter… LeCroy

Customer Support
3385 Scott Blvd.
Santa Clara, CA 95054

Send e-mail… support@catc.com
Visit LeCroy’s web site… http://www.lecroy.com/
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Coverage During Warranty Period
During the Warranty Period, LeCroy or its authorized representatives will repair or 
replace Products, at LeCroy's sole discretion, covered under this limited warranty 
that are returned directly to LeCroy's facility or through LeCroy's authorized 
representatives.

How to Obtain Warranty Service
To request warranty service, you must complete and return the registration card or 
register via the internet within the fifteen day period described above and report 
your covered warranty claim by contacting LeCroy Technical Support or its 
authorized representative.  

You can reach LeCroy Technical Support at 800-909-7112 or via email at 
support@catc.com.  You may also refer to the LeCroy website at 
http://www.lecroy.com for more information on how to contact an authorized 
representative in your region.  If warranty service is required, LeCroy or its 
authorized representative will issue a Return Material Authorization Number. You 
must ship the Product back to LeCroy or its authorized representative, in its original 
or equivalent packaging, prepay shipping charges, and insure the shipment or 
accept the risk of loss or damage during shipment. LeCroy must receive the Product 
prior to expiration of the Warranty Period for the repair(s) to be covered.  LeCroy 
or its authorized representative will thereafter ship the repaired or replacement 
Product to you freight prepaid by LeCroy if you are located in the continental 
United States.  Shipments made outside the continental United States will be sent 
freight collect.

Please remove any peripheral accessories or parts before you ship the Product. 
LeCroy does not accept liability for lost or damaged peripheral accessories, data or 
software.

LeCroy owns all parts removed from Products it repairs. LeCroy may use new 
and/or reconditioned parts, at its sole discretion, made by various manufacturers in 
performing warranty repairs. If LeCroy repairs or replaces a Product, the Warranty 
Period for the Product is not extended.

If LeCroy evaluates and determines there is "no trouble found" in any Product 
returned or that the returned Product is not eligible for warranty coverage, LeCroy 
will inform you of its determination.  If you thereafter request LeCroy to repair the 
Product, such labor and service shall be performed under the terms and conditions 
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of LeCroy's then current repair policy.  If you chose not to have the Product repaired 
by LeCroy, you agree to pay LeCroy for the cost to return the Product to you and 
that LeCroy may require payment in advance of shipment.
General Provisions
THIS LIMITED WARRANTY GIVES YOU SPECIFIC LEGAL RIGHTS.  YOU 
MAY HAVE ADDITIONAL RIGHTS THAT VARY BY JURISDICTION.  
LECROY'S RESPONSIBILITY FOR DEFECTS IN MATERIALS AND 
WORKMANSHIP IS LIMITED TO REPAIR AND REPLACEMENT AS SET 
FORTH IN THIS LIMITED WARRANTY STATEMENT. EXCEPT AS 
EXPRESSLY STATED IN THIS WARRANTY STATEMENT, LECROY 
DISCLAIMS ALL EXPRESS AND IMPLIED WARRANTIES FOR ANY 
PRODUCT INCLUDING, BUT NOT LIMITED TO, ANY IMPLIED 
WARRANTIES OF AND CONDITIONS OF MERCHANTABILITY AND 
FITNESS FOR A PARTICULAR PURPOSE, AND ANY WARRANTIES THAT 
MAY ARISE FROM ANY COURSE OF DEALING, COURSE OF 
PERFORMANCE OR TRADE USAGE.  SOME JURISDICTIONS MAY NOT 
ALLOW LIMITATIONS ON HOW LONG AN IMPLIED WARRANTY LASTS, 
SO THE PRECEDING LIMITATION MAY NOT APPLY TO YOU.

LECROY DOES NOT ACCEPT LIABILITY BEYOND THE REMEDIES SET 
FORTH IN THIS LIMITED WARRANTY STATEMENT OR FOR 
INCIDENTAL OR CONSEQUENTIAL DAMAGES INCLUDING, WITHOUT 
LIMITATION, ANY LIABILITY FOR THIRD PARTY CLAIMS AGAINST 
YOU FOR DAMAGES, PRODUCTS NOT BEING AVAILABLE FOR USE, OR 
FOR LOST DATA OR SOFTWARE.  LECROY'S LIABILITY TO YOU MAY 
NOT EXCEED THE AMOUNT YOU PAID FOR THE PRODUCT THAT IS THE 
SUBJECT OF A CLAIM.  SOME JURISDICTIONS DO NOT ALLOW THE 
EXCLUSION OR LIMITATION OF INCIDENTAL OR CONSEQUENTIAL 
DAMAGES, SO THE PRECEDING EXCLUSION OR LIMITATION MAY NOT 
APPLY TO YOU.

The limited warranty on a Product may be transferred for the remaining term if the 
then current owner transfers ownership of the Product and notifies LeCroy of the 
transfer.  You may notify LeCroy of the transfer by writing to Technical Support at 
LeCroy, 3385 Scott Blvd., Santa Clara, CA 95054 USA or by email at: 
support@catc.com.  Please include the transferring owner's name and address, the 
name and address of the new owner, the date of transfer, and the Product serial 
number.
 107



 UWBTracer User ManualLeCroy SW Version 1.10
108


	LeCroy UWBTracer™ User Guide
	Table of Contents
	List of Figures
	List of Tables
	1. Overview
	1.1 UWBTracer Ultra-Wideband Analyzers
	1.2 Ultra-Wideband Technology

	2. General Description
	2.1 System Components
	2.2 UWBTracer Front Panel Description
	Front Panel LEDs
	Front Panel Pushbutton

	2.3 UWBTracer Rear Panel Description

	3. Installation
	3.1 Analyzer PC Requirements
	3.2 Installing the UWBTracer Software
	3.3 Setting Up the Analyzer
	3.4 Connecting the Analyzer to the Device Under Test
	3.5 Installing the Cable Adapter
	3.6 Cable Adapter Pin Assignments
	3.7 Making a Recording
	Starting Recording
	Stopping Recording
	Interrupting the Upload Process
	Saving the Trace


	4. External Interface Breakout Board
	4.1 Breakout Board Overview
	4.2 Data In/Out Connector

	5. Software Overview
	5.1 Starting the UWBTracer Program
	5.2 Opening Sample Traces
	5.3 Opening Older Trace Files
	5.4 Tool Tips
	5.5 Trace Tool-Tips
	5.6 Menu Bar
	5.7 Tool Bar
	General Buttons
	Hide Buttons
	Reports Buttons
	Decode Buttons

	5.8 Floating the Decode Toolbar
	5.9 Pop-Up Menus
	Left Mouse Button
	Right Mouse Button

	5.10 Status Bar
	Recording Progress
	Recording Status
	Recording Activity
	Search Status

	5.11 View Settings Tools
	Zoom In
	Zoom Out
	Wrap

	5.12 Adding Comments to the Trace
	5.13 Set Marker
	5.14 Edit or Clear Marker
	5.15 Timing Calculations on Markers

	6. Display Options
	6.1 Display Options Overview
	6.2 Display Options: General
	6.3 Display Options: Color, Formatting, and Hiding
	Setting Colors
	Changing Field Formats
	Hiding Fields

	6.4 Saving Display Options

	7. Recording Options
	7.1 Recording Options Overview
	7.2 Recording Options: General
	Recording Type
	Options
	Buffer Size
	Trigger Position
	Options Name
	Trace Filename and Path

	7.3 Recording Options: Miscellaneous
	Debug
	Advanced

	7.4 Recording Options: Recording Rules
	Recording Rules Toolbar
	Recording Rules Page: How It Works
	Recording Rules Pop-Up Menus
	Events and Event Properties
	Actions and Action Properties
	Using a Single-State Sequence
	Using a Multi-State Sequence
	Using Independent Sequences


	8. Reading Traces
	8.1 Trace Display Overview
	8.2 Trace Level Views
	Changing Trace Level Views


	9. Searching Traces
	9.1 Trace Search Overview
	9.2 Go to Trigger
	9.3 Go to PLCP/Packet/Transaction/Transfer...
	9.4 Go to Marker
	9.5 Go to
	9.6 Find
	Areas in Find Window
	Direction/Origin


	10. Reports
	10.1 Trace Reports Overview
	10.2 File Information
	10.3 Traffic Summary
	Traffic Summary Buttons
	Using the Traffic Summary

	10.4 Error Summary
	10.5 Timing Calculations
	10.6 Real-Time Statistics
	Graph Area
	General Statistics Area


	11. Updates and Licensing
	11.1 Updates Overview
	11.2 Software, Firmware, and BusEngine Versions
	11.3 Software Updates
	11.4 BusEngine and Firmware Updates
	Automatic Update of BusEngine and Firmware
	Manual Update of BusEngine and Firmware

	11.5 License Information
	11.6 Updating the Software License

	A. Specifications
	How to Contact LeCroy
	Limited Hardware Warranty


